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First 
Impressions 
Matter.
Well-designed materials 
improve comprehension, student 
engagement, and retention. 

Course material should be consistent and 
organized so learners can process information 
easier and can distinguish what course they are in. 

Poor design leads to instant cognitive overload 
and misunderstandings. 
Wright State Online is creating an accessible, online, Quality 
Course Design Template to share with faculty Spring 2025.
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The Importance of Layout

Thoughtful, well-aligned layout prioritizes the 
user and their experience. 

•	A well-structured layout should guide the user’s eye through 
content naturally.

•	It reduces cognitive overload, making information easier to 
process for your learners. 

•	Helps learners quickly find what they need without frustration. 
•	Supports accessibility by ensuring content is clear and easy to 

navigate–especially for screen readers.
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The Importance of Layout
Some good practices to follow when laying out your content:

1.	 Whitespace in visual design. 
Avoid overcrowding. Give your content room to breathe. 

2.	 Follow a visual hierarchy. 
Place the most important info where users will see it first. 

3.	 Consistent formatting and alignment. 
Keep headings, font sizes, and spacing in your documents uniform. 
Use indentation tools properly– do not use unnecessary spaces as screen readers will pick this up.

4.	 Use images and graphics thoughtfully. 
If you are using visuals, make sure they are relevant to your material and what you are trying to convey.



Whitespace in Visual Design
Whitespace (also called negative space) isn’t “empty” space—it’s an essential design element that 
improves readability, focus, and user experience. 

Legibility: 

Clarity: 
Without white space to separate elements, a design can become overwhelming. If it’s not clear which 
elements belong together and which don’t, users are in for a confusing experience. Add whitespace to 
help learners focus on one element at a time.

Harmony: 
Harmony is important in design because it creates an effect of unity or 
completeness.
Example shows good vs. bad harmony.

THE IMPAC T OF GOOD DE S IG N



Visual Hierarchy
Visual hierarchy is the arrangement of design elements in a way that naturally guides the viewer’s eye 
through content. As a course designer, your job is to make sure learners can quickly understand what’s most 
important by having a strong visual hierarchy.

Good Practices:
•	Use large, bold headings so key sections are easy to identify.
•	Use styled headings H1, H2, H3, H4, ...
•	Place important information at the top of a page or module, or make sure there are visual cues guiding 

attention towards it.

Common Mistakes:
•	Do not overuse bold, or a certain color, or underline anything besides hyperlinks. 
•	Without variation in size, weight, or color, nothing stands out. 
•	If everything is bold or highlighted, nothing is actually emphasized.
•	Disorganized content makes it harder for students to navigate and absorb. Remember, good harmony!
•	Centering all your text isn’t accessible. Left-align body text for a natural flow.
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Consistent Formatting & Alignment
Good Practices:

Stick to 1-2 fonts; or 1 font–family with a wide variety of styles. 
One font family may have up to 10+ styles! That’s over 10 different ways to style! (Don’t go overboard.)

Align text and elements neatly. 
Left-align your body text. Center-alignment can be used for titles or emphasis.

Use a grid! 
It’s a very easy way to make sure all the elements on your screen are aligned. 

Maintain a predictable structure.
Students don’t want to relearn formatting in each module. 

Only underline hyperlinks.
This is a consistent rule. 

Common Mistakes:
•	Mixing centered, left, and right-aligned text. 
•	Overuse of different fonts or sizes creates confusion.
•	Inconsistent margins or padding make layouts look messy and unstructured.
•	Images should align with surrounding content and not feel like they are floating, or out of place.
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Consistent Formatting & Alignment
Working with gridlines in Powerpoint:
Gridlines help give you visual cues when you’re formatting in PowerPoint.

Note: To make sure your gridlines are turned on, go to 
the View tab and select the Gridlines checkbox.

The default horizontal and vertical gridlines will make a grid of one-inch squares. 

You’ll want to turn on the snap-to options. This will allow elements to gravitate towards the grid 
or “snap to” for easier alignment. 



How-to turn on the snap-to options in Powerpoint:

For Windows:

1.	 Select View on the ribbon, and in the Show group, select the dialog-box launcher.

2.	 The Grid and Guides dialog box appears.

3.	 To position shapes or objects to the closest intersection of 
the grid, under Snap to, check the Snap objects to grid box.

4.	 To see the grid on your screen, under Grid settings, check 
the Display grid on screen box.

For macOS:

1.	 Select View > Guides > Snap to Grid.



E X A MPLE OF G R IDLINE S IN A DOBE INDE S IG N



THE IMPAC T OF GOOD DE S IG N

Use Images & Illustrations Thoughtfully
Is it relevant? Images should support your content, not distract from it.

Good Practices:

•	Use high-quality, relevant images. 
•	Choose clear, professional images that reinforce key concepts and do not clutter content.
•	Stick to similar colors and/or illustration styles for a cohesive look.
•	Use alt text and describe your image thoughtfully. What is the image trying to convey in your material?
•	Avoid placing text over images and if you are, use an overlay that provides proper text contrast.
•	Follow copyright guidelines and attribute all images, including printed materials.

Common Mistakes:

•	Too many visuals can be overwhelming.
•	Using low-res or stretched images. If your student cannot see what’s relevant, probably best not to 

include it.
•	Ignoring accessibility. Big NO-NO. Images without alt text exclude visually impaired learners.
•	Relying on clipart or overly cartoonish graphics. Images should align with surrounding content and not 

feel like they are floating out of place. 



1.	 Consistent Colors, Fonts, and Styles.
Stick to a predefined color palette, as well as font(s) and styles throughout all your 
course materials. We’ll talk more about which fonts are recommended here shortly.

2.	 Consistent Iconography.
If using icons in your materials, make sure the line weight and colors are consistent. 

3.	 Keep a Similar Layout Across Modules.
Maintain a familiar structure for easier navigation for students.
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Consistency is Key
Some good practices to ensure consistency throughout your course: 



Consistent Colors, Fonts, and Styles
Use the same colors, fonts, and styles throughout. 

Take advantage of color palettes already made and use the same hex codes to make sure colors 
are aligning throughout all modules and assisting material. 

What the hex is a hex code?
A hex code (hexadecimal code) is a six-digit alphanumeric code (starting with a “#”) used to 
represent colors especially in web design and coding.
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Consistent Colors, Fonts, and Styles
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Using Heading & Paragraph 
Styles in Microsoft Word

Creating a New Style:
1.	 Go to the Home tab on the ribbon. 

2.	 Find the Styles gallery.

3.	 Use header styles from here, or edit your own 
using the Styles Pane on the right hand side.



Consistent Colors, Fonts, and Styles
Creating Heading & Paragraph Styles in Microsoft Word, Ctd.

Adding to the Styles Gallery (Optional):

•	If you want quick access to your new style, right-click it in the Styles gallery, click Modify, 
and then select “Add to Styles gallery” at the bottom of the dialog box.

•	You can also choose to have the style appear in all new Word documents by selecting 
“New documents based on this template” in the same dialog box. 

Save as a Template (Optional):

•	If you want to save your styles as a template for future use, go to File > Save As.

•	Select “Word Template” from the “Save as type” drop-down menu.

•	Give the template a name and click Save. 
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Consistent Iconography
Use consistent icons in your course materials. 
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Stick to either outline, solid, or flat icons—don’t mix styles. 
•	Icons should be proportional and not overpower the supporting text.
•	They should be universally recognized (for example, a magnifying glass for search).
•	Provide text descriptions for clarity and accessibility.
•	NounProject.com is a great resource for free icons!



Keep a Consistent Layout Across Modules
Structure modules with the same format so learners know where to find materials 
each week. Predictable structure helps students focus on content rather than figuring out where 
things are.

Place key elements in the same spot, and keep your Pilot module titles uniform by naming 
your materials properly.

This helps the learner navigate quicker throughout the course and become familiar with the 	 course 
shell and modules.

Maintain your visual hierarchy. 
Use consistent headings, fonts, and spacing across all modules.

Test for usability!
Is your course user-friendly? View your course as a student to ensure the layout makes sense.
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WSU Brand Color Palettes
Keep the WSU Brand in mind when designing your content.

When designing your digital media, you’ll want to adhere by the WSU Brand Resources. 

The Accent Color Palette should only be used to support and complement the primary color 
palette. Do not build a layout around accent colors. The Wright State colors and brand must be 
recognizable and prominent.

The Primary Color Palette consists of Wright State Green #046A38 & Wright State Gold #CBA052.



Color Palette Platforms
Two favorite color palette platforms, both let you browse, find, and easily click & copy the hex 
codes all in 1–click!:  

Coolors
Coolors takes an interactive approach with their Color Palette Generator. 

The generator fills the entire screen with a color palette that will refresh at every touch of the space 
bar. You can lock colors, favorite colors, and copy hex codes with one click. You can also explore their 
trending palettes voted on by thousands of other users. 

Coolors also offers a Contrast Checker.

Color Hunt
Color Hunt is a site tailored to designers and artists showcasing a multitude of hand-picked palettes. 
The site allows you to create a free account and save palettes to your own collection for future 
inspiration.
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Ways to Incorporate Consistency
Use the same fonts throughout your materials.

If using the typeface Lato in the LMS, perhaps you do the same with documents 
built outside of Pilot.

The university has recommendations for both a serif and sans-serif for use in your 
materials, which we’ll cover next.

What’s the difference between serif & sans–serif?

Serif fonts have decorative strokes, or ‘little feet’. They are traditional, formal, 
and usually tailored towards printed materials such as brochures, books, and 
professional reports.

Sans-serif fonts do not have these embellishments and have a clean appearance. 
They are easier to read on screens, especially at smaller sizes.

Best Practice: Use a sans-serif when designing for online content.
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Recommended Typography
Wright State recommends these fonts for use in your materials:

FOR HEADINGS:

Univers LT Standard
Univers is a contemporary sans serif font, and is useful as headlines, call-outs, sidebars, etc.

Source Sans Pro
Source Sans Pro, now known as Source Sans 3 is an alternative to Univers and is free from Google. 
Download Source Sans 3 here

FOR BODY TEXT/PARAGRAPHS:

Minion Pro
Minion Pro is most often used as body copy in brochures and printed material. It is a serif font which makes reading 
paragraph copy easier to read. The little “feet” help lead the eye from character to character, word to word, and is what 
makes this typeface a serif font. 
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Typography

Typography isn’t just about choosing a nice font—it 
directly affects how well students engage with and 
comprehend course materials. 
•	Poor font choices can cause eye strain and make learning frustrating. 
•	Properly chosen fonts, sizes, and spacing improve accessibility and 

readability for everyone.



BR A NDING

Typography– Best Practices

Use Sans-Serif Fonts for Digital Content. 
Fonts like Source Sans 3, Verdana, Open Sans, or Lato 
are easier to read on screens.

Keep Line Length Between 50–75 Characters.
Prevents eye fatigue and helps with readability.

Use Hierarchy Effectively.
Headings should be tagged as such for screen readers. 
They should be larger and bolder, with body text 
smaller and regular weight.

Left-Align Your Text.
More natural for reading than centered or justified text.

Maintain Consistent Typography.
Stick to one or two fonts throughout course materials. 

Choosing a font with many styles such as condensed, 
black, display, etc., lets you get creative while staying 
consistent.

Use Adequate Line Spacing.
A good recommendation is usually 1.5x line height. 
This improves readability, especially for students with 
dyslexia or visual impairments.

Ensure High Contrast.
Dark text on a light background (or vice versa) for 
accessibility compliance.
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Typography– Common Mistakes

NO-NO: Using Decorative or Script Fonts for Body 
Text. 
Hard to read, especially on screens.

NO-NO: Using Text That’s Too Small.
Usually anything under 10pt for body text makes 
reading difficult.

NO-NO: Overloading Slides with Text.
Keep content concise to maintain engagement.

NO-NO: Center or Justified Alignment for Large 
Blocks of Text.
Creates uneven spacing and reduces readability.

NO-NO: Too Many Different Fonts.
Creates a cluttered and unprofessional look.

NO-NO: Using Underlines for Emphasis.
Underlines should only indicate hyperlinks. Bold works.

NO-NO: Poor Contrast (Gray Text on White, Neon 
Colors).
Makes reading difficult and fails accessibility 
compliance.



Installing Fonts
Once you’ve downloaded your new font, you’ll need to know which file directory to put it in to ensure it 
will show up in all of your apps when designing. 
(You’ll want to make sure the file of your new font is properly placed into the directory required by your system.)

macOS
System font location:	 Macintosh HD > Library > Fonts
Apple makes the process easy with its built-in font manager app, Font Book. It is located under Applications, and can 
easily be pinned to your dock for future use. Text downloads can be placed into the application for a quick upload.

Windows
System font location:	 C:\Windows\Fonts
If you find you’re unable to move fonts to that location, use C:\Users\Username\AppData\Local\Microsoft\Windows\
Fonts\ to install fonts that can only be accessed by your username.

*Adobe offers a Troubleshooting Guide for Font Issues if you run into any tricky situations.
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Proper contrast and readability are essential for ensuring 
that all learners—including those with visual impairments 
or difficulties reading—can access the content.  

•	Following contrast guidelines helps meet ADA & WCAG standards, 
making content readable for all learners, including those with low 
vision or color blindness.

•	Poor contrast makes reading difficult, reducing comprehension and 
retention. It is straining on the eyes.

•	Avoid color-only distinctions. Use bold, icons, or patterns in addition 
to color to convey meaning for colorblind users.

•	Check contrast ratios. Ensuring at least a 4.5:1 contrast ratio for 
regular text and 3:1 for large text (use a contrast checker tool).

•	Avoid busy, patterned backgrounds and neon colors.

Contrast and Readability
BR A NDING



Good Practices:

High Contrast. 
Black or dark gray text on a white or off-
white background provides optimal 
readability. 

Use colorblind-friendly palettes.
davidmathlogic.com/colorblind  10/10

Limit your palette to 3–5 colors.
The content is what’s important. Not 
illustrating your presentation.

Common Mistakes:

Low Contrast. 
Light-colored text on a light background.

Too many bright/neon colors 
This is distracting! 

Keep Backgrounds Simple. 
This prevent distractions and maintain 
legibility. White background works best.

Overcrowding a page.
Keep line length 50-75 characters per line 
(including spaces). 
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Contrast and Readability



The graphic on the right gives a glimpse into 
what a colorblind user may see compared to 
someone with normal vision. 

Thankfully, contrast checkers like WebAIMs Color 
Contrast Checker exist to assist us as we design. 

When designing your modules and announcements 
in Pilot, make sure to use the built-in color contrast 
checker before publishing your content. We’ll take 
a look at some examples.

davidmathlogic.com/colorblind

Infographic showing the different colors seen for those who are colorblind.  

Contrast and Readability
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This header works.
This small paragraph text does not.
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Nope.
This isn’t accessible. I can’t even read it as 
I’m typing it.

E X A MPLE OF PILOT ’S BU ILT- IN COLOR CONTR AS T CH ECK E R
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This header passes.
This also is acceptable.

E X A MPLE OF PILOT ’S BU ILT- IN COLOR CONTR AS T CH ECK E R



BrightSlide Color Contrast Report for PPT
Free for Windows & Mac

Following Federal 508 Compliance 
Guidelines, this add-on will produce 
a Color Contrast Report using all the 
theme colors in your presentation.

The example shows Powerpoint’s 
default palette and which ones are 
passing on the left-hand side there 
with that 4.5:1 contrast. 

Download Powerpoint 
BrightSlide Add On
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Stock Imagery
Adobe Stock
Adobe Stock is a vast library of royalty-free images, illustrations, videos, templates, and more that 
can be used to enhance course materials, presentations, and online modules.

It is integrated with Adobe Creative Cloud and is included with your WSU Creative Cloud account.

Pexels
Pexels is a free stock photo and video library that provides high-quality, royalty-free visuals for use in 
educational materials, course pages, presentations, and more. 

Unlike paid stock services, all content on Pexels is available at no cost and can be used without attribution 
(though crediting creators is encouraged).
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WSU Online Photography Store
Wright State offers our own 
photography online at the Wright 
State Photography Store through 
SmugMug.
The Wright State community can request digital 
files free of charge through a Service Now request 
to Marketing through their website.

You will want to make sure you have the file 
number associated with the images you are 
ordering.
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WSU Branded Templates
The University supplies a PowerPoint 
Template (PPTX) for free use.
The template includes six cover designs and 
two inside slide designs. Instructions on how 
to navigate the template are included in the 
download.



WSO Resource Library

Wright State Online offers ongoing online support with our Online Resource Library 
including guides, trainings, and more, to ensure our faculty receive tools to help 
design an inclusive course for Wright State’s learners. 

Stay updated with WSO on furthering Accessibility and Course Design topics as we continue the 
effort to improve all learners’ experiences!
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•	https://www.flux-academy.com/blog/the-importance-of-whitespace-in-design-with-examples

Logo Credits:

•	Art Design by Tippawan Sookruay from Noun Project
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•	WSU SmugMug Store: https://wrightstate.smugmug.com/
•	WSU Order Photos Service Now: https://wrightstate.service-now.com/sp/nav_to.do?uri=%2Fcom.glideapp.
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